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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.  

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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Preface

Purpose of the User Manual

This document describes the steps necessary to start development of your 
PlantPAx® DCS system. Procedures step you through how to take default 
PlantPAx system attributes and customize them for your specific
system requirements.

To receive the maximum benefit from this document, we assume that your 
infrastructure is configured in accordance with the procedures documented
in the PlantPAx DCS Infrastructure Configuration User Manual,
publication PROCES-UM001.

We suggest that you perform the tasks in the order that is outlined in each 
chapter. However, each task has standalone screen facsimiles and step-by-step 
procedures to let you skip to other chapters if necessary. Each chapter has a 
flowchart that summaries the topics, similar to a mini Table of Contents.

Figure 1 shows the documents (this manual in the highlighted section) that are 
available to help design and implement your system requirements.

Figure 1 - PlantPAx System Implementation and Documentation Strategy

• Define and Procure – Helps you understand the elements of the 
PlantPAx system to make sure that you buy the proper components.

• Install – Provides direction on how to install the PlantPAx system.
• Prep – Provides guidance on how to get started and learn the best 

practices to follow before you develop your application.
• Develop – Describes the actions and libraries necessary to construct 

your application that resides on the PlantPAx system.
• Operate – Provides guidance on how to verify and maintain your 

systems for operation of your plant.

Define and
Procure Install Prep OperateDevelop

• Selection Guide
PROCES-SG001

• Virtualization User Manual
9528-UM001

• Infrastructure User Manual
PROCES-UM001

• Reference Manual
PROCES-RM001

• Application User Manual
PROCES-UM003

• Reference Manual
PROCES-RM001

• Library of Process Objects
PROCES-RM002
PROCES-RM013
PROCES-RM014

• Verify and Troubleshoot User Manual
PROCES-UM004

• Reference Manual
PROCES-RM001
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Preface
New and Updated Information

This table contains the changes that are made to this revision.

Manual Conventions For instructional purposes, this manual uses visual tools to complement the 
procedures. Icons that represent system elements are shown at the start of a 
section to help identify the system element that is being configured in the steps.

The element’s abbreviation is listed with the icon for identification as shown in
the example.

See Table 1 for descriptions and abbreviations of the system element icons.

Topic Page

Illustration of how to build a PlantPAx application 13

Application Code Manager description and options 14, 16, 17

Use an engineering workstation 
with these procedures.

EWS

System Element Icon

System Element Identifier

System Element Description

Table 1 - Visual Naming Conventions

Icon Description Abbreviation Element Names Topic Page

Logix controllers • LGXC01 - Controller
• LGXC02 - Controller

 55, 59, 63

PlantPAx workstations • OWS01(1) - Operator workstation
• EWS01(1) - Engineering workstation

57, 135, 201, 233

PlantPAx Application servers • ASIS01 - AppServ-Info SQL server
• ASIH01 - AppServ-Info Historian server
• ASIV01 - AppServ-Info VantagePoint server
• ASAM01 - AppServ-Asset Management server
• ASBM01 - AppServ-Batch server
• ASEWS01 - AppServ-Engineering Workstation server 
• ASOWS01 - AppServ-Operator Workstation server

61, 201

PASS
(Process Automation System Server)

• PASS01 - FactoryTalk® Directory
• PASS02A - Primary HMI server
• PASS02B - Secondary HMI Server

61

(1) EWS and OWS are used throughout the manual but the same procedures apply for AppServ-EWS and AppServ-OWS.
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Preface
Action Identifier

Dialog boxes have red boxes to identify areas that require some type of user 
action, such as to type text or click ‘Next’.

Configure Programs Menu We strongly suggest that you perform the following procedure in the system 
computers to group folders under ‘Programs’ on the taskbar. When complete, 

you access Windows and software folders by clicking the Programs  symbol. 

1. Click the Windows  symbol.

2. Click Control Panel and choose Folder Options.
Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 9



Preface
The Folder Options dialog box appears.

3. On the View Tab, select ‘Show hidden files, folders, and drives’
and click OK.

4. Right-click in the taskbar, click Toolbars, and choose New Toolbar.

5. On the New Toolbar window, designate a path for your Programs folder.
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Preface
For example: 
C:\ProgramData\Microsoft\Windows\StartMenu\Programs.

6. Click Select Folder.
Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 11



Preface
Additional Resources These documents contain additional information that concern-related 
products from Rockwell Automation.

You can view or download publications at
http://www.rockwellautomation.com/global/literature-library/overview.page. 
To order paper copies of technical documentation, contact your local 
Allen-Bradley distributor or Rockwell Automation sales representative.

Resource Description

PlantPAx Distributed Control System Selection Guide,
publication PROCES-SG001

Provides basic definitions of system elements and
sizing guidelines for procuring a PlantPAx system.

PlantPAx Distributed Control System Reference Manual, 
publication PROCES-RM001

Provides characterized recommendations for
implementing your PlantPAx system.

PlantPAx Distributed Control System Infrastructure
Configuration User Manual, publication PROCES-UM001

Provides procedures to configure infrastructure
components for your PlantPAx DCS systems.

PlantPAx Distributed Control System Verification and 
Troubleshooting User Manual, publication PROCES-UM004

Describes how to verify that your system design aligns 
with PlantPAx system recommendations.

Rockwell Automation Library of Process Objects Reference 
Manual, publication PROCES-RM002

Provides information on how to use the Rockwell 
Automation Library of Process Objects.

Rockwell Automation Library of Process Objects:
Logic Instructions Reference Manual,
publication PROCES-RM013

Describes controller codes and tags for Library objects. 
The objects are grouped by family and attached as 
Microsoft Excel files to the manual PDF file.

Rockwell Automation Library of Process Objects: Display 
Elements Reference Manual, publication PROCES-RM014

Provides common display elements for the Rockwell 
Automation Library. For improved accessibility, the 
elements are combined into one manual.

PlantPAx Virtualization User Manual,
publication 9528-UM001

Describes the catalog numbers and details for
using virtual image templates to configure
virtual machines.

Application Code Manager User Manual,
publication LOGIX-UM003

Provides procedures for installing and creating
projects and configuring library objects.

Product Compatibility and Download Center at
http://www.rockwellautomation.com/rockwellautoma-
tion/support/pcdc.page

Website helps you find product-related downloads 
including firmware, release notes, associate
software, drivers, tools, and utilities.
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Chapter 1

Build a PlantPAx Application

The illustration shows the basic steps for building a PlantPAx® application.

IMPORTANT Before starting the procedures in this manual, the following prerequisites 
are assumed to be completed:
• System requirements are defined via Piping & Instrumentation

drawings (P&ID), Input/Output (I/O) lists, User Requirement and/or 
Functional Requirement Specifications (URS/FRS), and so on.

• System is properly sized by using the PlantPAx System
Estimator (PSE) and in accordance with the PlantPAx Selection
Guide, publication PROCES-SG001.

• Infrastructure (equipment, media) is configured per instructions in the 
PlantPAx DCS Infrastructure Configurations User Manual,
publication PROCES-UM001.
Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 13
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Chapter 1 Build a PlantPAx Application
You can use the Studio 5000® Architect application or the Studio 5000® 
Application Code Manager (ACM) with a Logix controller. The two software 
tools are different in form and function:

• Architect – A visual tool that helps you design a system with
drag-and-drop capability to show equipment on a canvas. Architect 
contains the Rockwell Automation Library of Process Objects to allow 
for quicker import of Library objects to start projects. We show
step-by-step procedures in this section for how to add process strategies 
to controllers for control of process devices.

• ACM – A tool that lets you bulk engineer code from physical devices on 
the P&ID to build controller, HMI, and Historian files. There is less 
programming because you can identify (decorate) reusable tags for bulk 
production. The Logical Organizer Designer plug-in creates HMI and 
Historian tags. The Logical Organizer Manager builds an application to 
create the library. Library objects can be configured to meet the needs of 
multiple applications.

For more information, see the Application Code Manager User Manual, 
publication LOGIX-UM003.

We strongly recommend that you decide the software tool to use while you 
compile the I/O list with the P&ID drawing.

Considerations Consider the following suggestions before starting this chapter:
• The Architect or ACM application must be installed on an

Engineering workstation.

• Check for the latest version of the Process Library in the
Product Compatibility and Download Center (PCDC) before 
initiating projects.

• We recommend that you perform all I/O configuration inside the
Logix Designer application.

IMPORTANT The procedures in this chapter focus on the Architect application because its 
graphical design helps you get started from scratch with the PlantPAx 
Library. The interface also aids system maintenance. ACM users typically 
have more experience creating bulk core projects.

IMPORTANT You can access the PCDC from the Architect application. See page 19 
for details.
14 Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019
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Build a PlantPAx Application Chapter 1
Figure 2 shows a list of the topics in this chapter. Click or see the page number 
for access to a section.

Figure 2 - Studio 5000 Architect Workflow

Start

Architect or ACM Option

page 16

Organize Your Controller Folders

page 25

Multi-controller CommunicationSee Chapter 2

Build Process Strategies

page 32

Sync Controller to System

page 50

• Controller Organizer
• Logical Organizer

• PS_AIn_Chan
• PS_PID_AIn_Chan
• PS_PF755

• Using ACM Bulk Tags
• Using the Architect Palette

Create an HMI Application

page 20
• Commit a Project
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Architect or ACM Option Whether you are a novice or experienced user, we suggest that you review the 
Architect palette (see page 17) or the ACM quick steps (depending on which 
is being used) before proceeding.

Using ACM Bulk Tags

As stated in the overview, ACM execution is a matter of registering, adding, 
and configuring bulk Library objects. Projects can be completed without 
requiring high-end programming support. In the project work flow, engineers 
configure the object parameters to meet the requirements of the current 
application. The project is then created to ACD controller code.

Control strategies contain pre-engineered code in the form of Add-On 
Instructions. The HMI Library provides the faceplates for the Add-On 
Instruction display elements.

The decorated ACD file and library objects are published directly to the ACM 
database or to a file in HSL4 format. HSL4 files comprise a library of 
application code with control strategies.

You can add non-Logix user interface features, such as HMI (FactoryTalk View 
SE/ME software) and Historian (FactoryTalk Historian SE software) 
components, to the Library object in the Library Object Manager application. 
This can be done only after the Library object has been published from the 
ACD file to a folder or ACM database repository.

ACM Quick Start

The following procedures are basic steps to register a Library and start a 
project. For details, see the Application Code Manager User Manual, 
publication LOGIX-UM003.

Register a Library

To extract a self-contained library, complete these steps.

1. From the directory where the ACM download folder is stored,
right-click the .zip folder and choose Extract All.

2. Click Start Menu and choose Rockwell Automation>Application
Code Manager.

3. Right-click and choose Register.

4. Select all extracted library files and click Open.

5. Click Finish.
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Start a Project

To create a new project, complete these steps.

1. From the main menu, select File>New and choose Project.

2. From the Object Configuration Wizard, select Basic_Project (2,1) and 
click Next.

3. Type a project name and click Finish.

4. To add a project to a controller, right-click Controllers in the left pane, 
and choose Add New.

5. From the ControlLogix Library, select a controller and click Next.

6. Type a name for the controller.

7. Select controller parameters and click Finish.

For parameter descriptions and more information, see the ACM
User Manual, publication LOGIX-UM003.

Using the Architect Palette

If you are using the Architect application, complete these steps to review
the palette.

1. To open the Studio 5000 Architect application, click the Programs  
symbol and choose Rockwell Software®>Studio 5000®.

The Studio 5000 Common Launcher appears.

2. Open a PlantPAx project.

Wait a few minutes while the ACD files and project data load.
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Chapter 1 Build a PlantPAx Application
The Architect canvas appears with a wire diagram of the application 
hardware for your project.

1
2

3

4

5

6

Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description

1 - Project Explorer In the upper, left corner, the Project Explorer lists the Logix Designer and 
FactoryTalk® View projects that comprise the Studio 5000 Architect 
Application. IMPORTANT: When you are in the Project Explorer, you are using 
the Architect application. You must open a project in the Explorer to access 
the Studio 5000 Logix Designer application. To avoid confusion, the words 
‘Architect’ and ‘Logix Designer’ are in the respective ribbon headers.

The system template that you select contains a number of controller and 
FactoryTalk View projects. Typically, there are more projects (than shown in 
the graphic example) that are contained in the Project Explorer as your 
system develops over time.

There is one FactoryTalk View software project titled ‘PlantPAx’. The three 
projects that are contained in the template are View ME, View SE Distributed, 
and View SE Station Local.

The Hardware Diagrams folder contains the components on the canvas that 
represent your PlantPAx system. See number 4 for more information on
the canvas.
18 Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019



Build a PlantPAx Application Chapter 1
2 - Toolbox In the upper, right corner, you can view hardware (switches, controllers, 
associated I/O modules, and so forth) in the project. 
There are two libraries that are listed as ‘Read Only’ to denote they cannot be 
modified or managed within Architect. 
User-defined libraries are supported in Architect. You must download the 
Rockwell Automation® Library of Process Objects from the Product 
Compatibility and Download Center (PCDC). See 5 - PCDC.

3 - Communications In the lower, left corner, the Communications pod shows the communication 
path from the PASS01 computer to the five controllers. These paths are
pre-defined shortcuts by using the Single Process Server template.

4 - Canvas In the middle section, the canvas shows a graphical representation of the 
system elements that comprise the application. You can drag-and-drop 
elements to modify a project.

The canvas also provides access to the Product Compatibility and Download 
Center (PCDC). See 5 - PCDC table description.

5 - PCDC In the upper, right corner of the canvas, 
click the Rockwell Automation logo. The 
Library filter appears to let you 
download the Process Library from the 
Product Compatibility and Download 
(PCDC) website.
The PCDC website provides access to the latest software and
hardware updates.

Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description
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Create an HMI Application To build your HMI objects and displays through drag-and-drop procedures in 
an Architect project, complete these steps.

1. To add the basic frame for the template, drag the Libraries>
Process Library>Templates>FactoryTalk® View SE>P2f Template from 
the Library Management pane and drop it into the PlantPAx
HMI folder.

2. In the Library Management pane, expand Libraries>Process 
Library>Common folders.

6 - Messages At the bottom of the canvas, the Messages area provides alerts, if any, for
the project.

Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description

IMPORTANT To customize a template, see the Rockwell Automation Library
of Process Objects: Configuration and Usage Reference Manual,
publication PROCES-RM002.
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3. Expand the FactoryTalk View SE folder and drag-and-drop into the 
PlantPAx HMI folder in the Project Explorer pane. 

4. In the Process Object folder, select the Object folder that is used in the 
application and drag-and-drop into the PlantPAx HMI folder.

5. Repeat step 4 for each object that you need.

6. Save your work.
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Commit a Project

The Commit option sends the data from an Architect project to the 
FactoryTalk View project for the respective servers: HMI, data, and alarm.

Complete the following steps:

1. In the Project Explorer pane, right-click the application (PlantPAx in 
the example) and choose Commit Project. 

2. Click Commit. 
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3. Click Close.

4. To confirm the commit action, in the Project Explorer pane, right-click 
the application (PlantPAx in the example) and choose Open Project
in Designer. 
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The FactoryTalk® View Studio window appears.

5. In the Explorer pane, open the 
PlantPAx>Area>PlantPAxHMI>Graphics>Displays folder.

This folder typically contains the FRAME, P2f, and RA-BAS
display files.
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Organize Your Controller 
Folders

This section shows how to configure your controller folders by using the 
following tabs in the Logix Designer application:

• Controller Organizer — Lists the execution tasks and I/O 
configuration

• Logical Organizer — Sorts in terms of procedures, objects, functions, 
equipment, or some other natural term or concept for a ‘logical’ model 
of your application

Controller Organizer

Complete these steps to organize your controller based on the execution rate of 
your tasks.

1. In Studio 5000 Architect, right-click a controller and choose Open 
Project in Designer.

IMPORTANT Before setting up system folders, we recommend that you review the 
controller guidelines in the PlantPAx Reference Manual,
publication PROCES-RM001.
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Chapter 1 Build a PlantPAx Application
The execution tasks appear in the Controller Organizer tab.
Periodic tasks are executed at specific rates that are based on
application requirements

Tasks
See Tip

TIP The controller template contains 
nine predefined periodic tasks, 
eight of these named Tasks 
A…H. There is a separate 
periodic task that is named 
Controller Status, which is used 
to collect system diagnostics. 
For example, the L_CPU Add-On 
Instruction monitors resources.
Each task is set to execute at a defined time interval from
50 ms…10 s, with faster tasks given higher priority.
See the Task Configuration guidelines in the PlantPAx Reference 
Manual, publication PROCES-RM001.
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2. To create a program, right-click a task and choose Add>New Program.

The New Program dialog box appears.

3. Type a program name (Equipment01 is the example) and click OK.

4. To create a routine within a program, right-click the name of the 
program that you created.

5. Click Add and choose New Routine.
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A Jump to Subroutine ( JSR) is going to be added to the program to 
execute a command. JSRs are explained later in this section.

6. Type ‘MainRoutine’ for the routine name and click the Assignment
pull-down menu to select Main.

7. Click OK.

The New Routine has been added.

Logical Organizer

The Logical Organizer creates an organizational model of your system. This 
model is a hierarchy of your system.

IMPORTANT Due diligence is required in the layout of your logical organizer. A
properly organized system within the logical organizer helps to simplify 
application development.
Several components of your PlantPAx system depend on the organization 
and hierarchy of your Process system. These components consist of
the following:
• HMI application
• Alarms
• User roles and responsibility
• Security
We recommend that you see these additional references:

– Chapter 6 of the PlantPAx DCS Infrastructure User Manual, 
publication PROCES-UM001

– Chapters 3…4 of this application manual
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Complete these steps to build your logical model.

1. From the controller that is being configured, click the Logical
Organizer tab.

2. Right-click the controller and choose Add>New Folder.

The New Program dialog box appears.

3. Type ‘System’ for the folder name and click OK.

The folder appears in the Logical Model list for the controller.
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4. Drag-and-drop the Diagnostics folder and all Task programs into the 
‘System’ folder. 

5. Right-click the controller and choose Add>New Folder.

6. Type a folder name and click OK.

7. Right-click the Process01 folder and choose Add>New Folder.

IMPORTANT  A Diagnostics task is included in all controller templates to provide 
for troubleshooting, reporting, and alarming of controller status 
and resources.
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8. Type a folder name and click OK.

9. Drag-and-drop the folder (Equipment01) into the program (Area01) 
folder. 

The controller folders are ready to Build Process Strategies on page 32.
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Build Process Strategies Procedures to add process strategies to controllers apply for Architect and 
ACM processes. The strategies, which are labeled ‘PS_’, contain pre-connected 
Process Library objects for control of process devices. Strategies are imported 
into your program to help reduce implementation time of your application.

Figure 3 - Process Strategy Example Using the P_PIDE Object

The following procedures do not encompass all available process strategies. 
The examples that are shown are a cross-section of the Rockwell Automation® 
Library of Process Objects that comprise the process strategies.

Program parameters are used for I/O connection. The Add-On Instruction 
tags are controller-scoped tags.

IMPORTANT To complete these procedures, you must have unzipped the process 
strategies folder within the Process Library download. See the PCDC at: 
https://compatibility.rockwellautomation.com/Pages/home.aspx
The procedures are written as if they are being performed online. However, if 
you are offline, the procedures can be used because they are similar.
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PS_AIn_Chan

The PS_AIn_Chan strategy lets you monitor a basic analog object with
channel capability.

1. From the Studio Architect application, right-click a controller that is 
being configured and select Open Project in Designer.

The Logix Designer application opens within the Architect tool.

2. Click the  tab.

3. Right-click the program (Equipment01 is the example) and choose
Add>Import Routine.

4. Browse the path to the Process Strategies folder and select the
(RA-LIB)PS_AIn_Chan_x_x-xx_ROUTINE.L5X.

5. Click Open.

IMPORTANT See page 32 for the path to the folder that you used to unzip the 
process strategies folder.
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The Import Configuration dialog box appears.

6. Click the Find/Replace button to find all tag references of ‘XT101’ and 
replace with a user-designated tag name.

Our example is ‘TT01001’.

7. Click Replace All.

Verify that the Final Name and 
Description boxes are checked.

IMPORTANT In the Find Within section at the bottom of the dialog box, the Final 
Name box defaults with a check mark only. The first time that you 
use this dialog box, you must check the Description box. Thereafter, 
the Description box defaults with a check mark.

TIP Click Close to exit Find/Replace only if you are done using the utility.
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8. Repeat step 6 and step 7 to find all tag references to ‘TagDescript’ and 
replace with a description.

Our example is ‘Temperature 01001’.

9. Click Close to exit Find/Replace.
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10. Click Tags to view all parameters that comprise the PS_AIn_Chan 
strategy.

.

11. Click OK to import the routine.
.

IMPORTANT If there are errors, a red ‘X’ with a message appears to describe
the issue.

IMPORTANT You must be online to view the dialog box for the next procedure.
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12. Select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.

The control strategy (PS_AInChan in our example) appears in the
Logix Designer application.

Add JSR Instructions

The Jump to Subroutine ( JSR) instruction directs the controller to ‘jump to’ 
and execute a separate subroutine file within the ladder program, and return to 
the instruction following the JSR instruction.

We use JSR instructions to schedule the routines that are added for execution. 
A JSR instruction must be created for each routine.
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1. From the Logical Organizer in the Logix Designer application,
double-click MainRoutine.

A JSR instruction can be added in the following ways:
• From the Program Control tab, click JSR (as shown in the example). 

(Click the left (<) and right (>) arrows to find the Program
Control tab.)

• Click the rung, type ‘JSR’ and press Enter. Double-click the routine 
name and select the created Process Strategy.

2. If online, click the Finalize All Edits in Program  icon.
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3. Click Yes.

4. Save the Logix Designer project.

PS_PID_AIn_Chan

The PS_PID_AIn_Chan strategy provides loop control with an analog object 
that has channel capability.

1. Repeat steps 1 through 3 on page 33.

2. On the Import Routine dialog box, browse the path to the
Process Strategies folder and select 
(RA-LIB)PS_PID_AIn_Chan_x_x-xx.ROUTINE.L5X.

3. Click Open.

IMPORTANT The procedures and screen facsimiles to create this instruction are similar to 
PS_AIn_Chan. For your convenience, we include the screen facsimiles that 
require specific information for this instruction.
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The Import Configuration dialog box appears.

4. Click the Find/Replace button to find all tag references to ‘XIC502’ 
and replace with a user-designated tag name.

Our example is ‘FIC01002’.

5. Click Replace All.
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6. Repeat step 4 and step 5 to find all tag references to ‘TagDescript’ and 
replace with a description.

Our example is ‘Flow Control 01002’.
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7. Click Find/Replace for all tag references to ‘XT502’ and replace with a
user-designated tag name.

Our example is ‘FT01002’.

8. Click Replace All.
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9. Repeat step 7 and step 8 to find all tag references to ‘DescAnalogInp’ 
and replace with a description.

Our example is ‘Flow 01002’.

10. Click Close to exit Find/Replace.
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11. Click Tags to view all parameters that comprise the P_PID_AIn_Chan 
code object.

12. Click OK to import the routine.

13. If online, select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.
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The control strategy (PS_PID_AIn_Chan) appears in the
Logix Designer application.

14. Complete the Add JSR Instructions as documented on page 37.

15. Save the Logix Designer project.

PS_PF755

The PS_PF755 strategy provides a PowerFlex® drive interface.

1. Repeat steps 1 through 3 on page 33 and page 33.

2. On the Import Routine dialog box, browse the path to the
Process Strategies folder and select 
(RA-LIB)PS_PF755_x_x-xx.ROUTINE.L5X.

3. Click Open.

IMPORTANT The procedures and screen facsimiles to create this instruction
are similar to PS_AIn_Chan. For your convenience, we 
include the screen facsimiles that require specific information
for this instruction.
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The Import Configuration dialog box appears.

4. Click the Find/Replace button to find all tag references to ‘MT310’ and 
replace with a user-designated tag name.

Our example is ‘MT01001’.

5. Click Replace All.
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6. Repeat step 4 and step 5 to find all tag references to ‘TagDescript’ and 
replace with a description.

Our example is ‘Motor 01001’.
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7. Click Tags to view all parameters that comprise the PS_PF755 strategy.

8. Click OK to import the routine.

9. If online, select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.

TIP If there are errors, a red ‘X’ with a message appears to define
the issue.
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The control strategy (PS_PF755) appears in the Logix
Designer application.

10. Complete the Add JSR Instructions as documented on page 37.

11. Save the Logix Designer project.
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Sync Controller to System Complete these steps to synchronize the controller changes with the system 
template inside the Studio Architect software.

1. From the Studio 5000 Architect application, right-click a controller that 
is being configured and choose Update Project Changes.

The Studio 5000 Architect Update Summary window appears.

The example shows the project that is expanded with the list of changes.

2. Click Update.

The Ethernet Configuration dialog box appears.

3. Leave the devices and their port configuration as is, and click OK.

A wait message appears while the project is being synchronized.
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To verify that the changes are synchronized with the system, complete
these steps.

1. From the Studio 5000 Architect application, right-click a controller 
strategy and chose Open Routine.

In the Logix Designer application, the program logic appears for the 
selected process strategy.
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2. From the Studio 5000 Architect toolbar, click Edit and choose Find.

3. From the Find text box, type the tag name.

Our example shows TT01001.

4. Click Start Search.
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The tags for the selected routine display underneath the system model 
on the Studio Architect software.

5. Save the Studio 5000 application.

The remaining chapters in this manual describe how to continue to build your 
application by adding the following:

• Produce/Consume tags
• Alarms
• Historian points
• I/O modules
• Diagnostics
• Asset management tools
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Notes:
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Chapter 2

Configure Controller-to-Controller 
Communication

This chapter describes how to establish a communication pipeline between 
controllers by creating produce/consume tags with a user-defined data
type (UDT). 

A Logix5000™ controller lets you produce and consume system-shared tags. A 
producer controller sends data to the system. The consumer controller is 
configured to consume the produced tag. The data type of the consumed tag 
must match the data type of the produced tag.

For controllers to share produced or consumed tags, the controllers
must be attached to the same network, such as a ControlNet® or
EtherNet/IP™ network. 

The consumed tags require connections. An increase in the number of 
controllers that consume a produced tag reduces the number of connections 
the controller has available for other operations. These operations include 
communication and I/O. 

Considerations Consider the following suggestions before starting this chapter:
• Producer/Consumer uses Class 1 communication (I/O) to enhance

data integrity and response time.
• The Producer/Consumer configuration is available only in offline 

mode. During the initial system configuration, we recommend that you 
create the communication between any system tags.

• If a controller is not consuming produced tags, we recommend that you 
inhibit the controller connection to save bandwidth.

LGXC01

Produced Tag LGXC01
Consumed Tag LGXC02

LGXC02

Consumed Tag LGXC01
Produced Tag LGXC02
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Figure 4 shows the topics that are described in this section. Click or see the 
page number for quick access to a section.

Figure 4 - Controller-to-Controller Workflow

See Chapter 3

Start

Create Produce/Consume Tags

See page 63

Configure Alarms

Create Produce/Consume Data Type

See page 57

Create Controller Network

See page 59
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Create Produce/Consume 
Data Type

Complete these steps to create a user-defined data type (UDT) that is shared 
between two or more controllers. Remember, the data type of the consumed 
tag must match the data type of the produced tag.

1. In the Controller Organizer of the Logix Designer application, click ‘+’ 
to expand the Data Types folder for the producer controller.

2. Right-click Data Types and choose New Data Type.

The New UDT dialog box appears.

3. To add members to your new data type, do the following:
a. Type a name. 

Our example is PC_UDT.
b. Click Add Member and type a name and data type.
c. Repeat step b for each new member of the UDT.
d. Click OK.

TIP For more information on configuring produced and consumed tags, see the 
Logix 5000 Controllers Produced and Consumed Tags
publication, 1756-PM011.

Use an Engineering Workstation
with these procedures.

EWS
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4. Save your work.

5. From the Studio 5000 Architect® application, right-click the producer 
controller and choose Update Project Changes.

In the Architect project, the UDT that you created appears in the
User-Defined list for the controller.

6. Drag-and-drop the new UDT into the other controller.

IMPORTANT The Consumer controller must use the Connection Status for the 
source quality of the information. If there is a loss of 
communication, the Connection Status reports the fault.
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The UDT is now in the User-Defined list for the consumer controller.

Create Controller Network This section describes how to add controllers and place the Producer controller 
definition into the Consumer controller. This action creates a network 
communication path.

Complete these steps.

1. On the Architect canvas, click and drag the adapter of the Producer 
controller and drop into the Consumer controller.

IMPORTANT To modify controller properties and add local communication adapters,
see the PlantPAx® Distributed Control System Infrastructure Configuration 
User Manual, publication PROCES-UM001. 
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For our example, LGXC02 is the Producer controller and LGXC01 is
the Consumer.

2. Use the defaults and click OK.

If necessary, you can change the IP address and then click OK.

Adapter
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3. On the Architect canvas, click and drag the controller for the Producer 
controller and drop into the Consumer controller.

4. Use the defaults and click OK.

5. Repeat step 1 through step 4 but with LGXC01 as the Producer 
controller and LGXC02 as the Consumer.

Controller
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The respective controllers are now linked and can communicate.

6. Save your work.
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Create Produce/Consume 
Tags

Complete these steps to attach produce/consume tags to a UDT for an
application controller.

1. In the Architect menu bar, click View and choose
Produce/Consume Tags.

2. In the Produce/Consume Tags window, click Add.

IMPORTANT Step 1 applies if you do not have Produce/Consume tabs on the 
bottom of the Architect application. Otherwise, click an existing 
Produce/Consume tab.
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The Consumer Tag dialog box appears.

3. Select ‘LGXC01’ in the Controller text box.

4. Type ‘LGXC02’ as the tag name.

5. Select PC_UDT from the Data Type pull-down menu.

The message ‘Producer tag must be defined’ appears.

6. Click Connection.
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The Producer Tag dialog box appears.

Make sure that the Producer controller is listed.

7. Set an RPI value and click OK.

Use the highest permissible RPI for your application. Follow the 
standard rule, which is, the RPI must be two times faster than the 
execution.
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The Consumer Tag dialog box reappears.

Observe in the Information box that you are creating a consumed tag 
with the same UDT as a produced tag with your selected RPI.

8. Click OK.

9. Repeat step 1 through step 7 with ‘LGXC02’ as the Producer controller
and ‘LGXC01’ as the Consumer.

The created tags appear in the Produce/Consume Tags window.
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10. Right-click in each controller and choose Commit Project Changes.

IMPORTANT Make sure that the Logix Designer application is closed before you 
Commit a project.
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Notes:
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Chapter 3

Configure Alarms

This chapter describes how to configure your process alarms in the
PlantPAx® system.

Alarms are a critical function of a distributed control system. Effective alarm 
systems direct the attention of an operator to improve the productivity, safety, 
and environment of a process plant. The PlantPAx system follows industry 
standards that govern alarm management.

This chapter does not cover the engineering practices that are required to fully 
apply alarm management standards. However, we describe the procedure that 
is required to implement alarms on the PlantPAx system. The steps make sure 
of system performance and alignment with the functionality expectations of 
the industry standards.

In addition, this chapter includes how to configure visualization components, 
including an alarm summary, alarm log viewer, and alarm banner (shown in the 
graphic). When a controller detects an alarm condition, the server publishes 
the information to a subscribing Operator workstation via FactoryTalk® Alarm 
and Event Services. 

IMPORTANT For information on the HMI template referenced in this chapter, see the 
Rockwell Automation Library of Process Objects: Configuration and Usage 
Reference Manual, publication PROCES-RM002.

IMPORTANT Install the Alarm Builder Tool to simplify alarm tag creation. Each alarm 
object that comprises the Library of Process Objects must be enabled for the 
tool to create the alarm.
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Figure 5 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 5 - Alarm Workflow

Start

Configure an Alarm Banner

See page 75

View an Alarm Summary

See page 80

Configure HistorianSee Chapter 4

Configure an Alarm Log Viewer

See page 83

View Alarm System Configuration

See page 86

Configure an Alarm Group

See page 71

Configure the Alarm Builder Tool by using the 
procedures in the Rockwell Automation® Library of 

Process Objects, publication PROCES-RM002

See Knowledgebase Answer ID 466418 at 
https://rockwellautomation.custhelp.com/ for more 

information on Alarm roll-up and filtering.

• Alarm Banner
• Alarm Sounds
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Considerations Consider the following suggestions before starting this chapter:
• Tag-based alarms are recommended to generate alarms in the PlantPAx 

system. Device-based alarms can be used, but we recommend that you 
limit their use to enhance system performance.

• Perform any alarm configurations in Chapter 8 of the PlantPAx
Distributed Control System Infrastructure Configuration
User Manual, publication PROCES-UM001.

• Before you configure alarms, organize and group your alarms based on 
your system. The alarms are organized by Level 1 through Level 3 as 
shown in the example.

• For more HMI template information, see the Rockwell Automation 
Library of Process Objects: Configuration and Usage Reference 
Manual, publication PROCES-RM002.

Level 1

Level 2

Level 3
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Configure an Alarm Group This section describes how to configure a group of alarms for a specific process 
area. Complete these steps for each group of alarms for each process area.

The following example shows a controller that has two areas.
• Area01 contains Equipment01 and 02.
• Area02 contains Equipment03 and 04.

Level 2
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1. Use Alarm Builder to import your alarms as documented in the 
Rockwell Automation® Library of Process Objects Reference Manual, 
publication PROCES-RM002. 

2. In the FactoryTalk View Studio software, open 
PlantPAx>Area>Alarm>PlantPAx_AE>Alarm and Event Setup. 

IMPORTANT When using Alarm Builder, it is expected that the Process Tree is 
created. To create the group organization, you must create the 
display association.
We recommend that you create an entire system organization by 
attaching multiple controllers, different programs, routines, and so 
forth. These items can be part of one group to be the foundation of 
the alarm grouping.
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The Alarm and Event Setup window appears. 

By following the Alarm Builder procedure, it is expected that the Alarm 
and Events Grouping is similar to the Process Tree organization.

3. To add more groups, right-click on your project (PlantPAx in the 
example) and choose Add Group.

Or, if you like, you can drag-and-drop groups and alarms.

4. Click the Save  icon.
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Configure an Alarm and 
Event Banner

This section how to configure the visual and audible components of an
alarm state.

For more information on how to customize an HMI template, see the 
Rockwell Automation Library of Process Objects: Configuration and Usage 
Reference Manual, publication PROCES-RM002.

Alarm Banner

Complete the following steps to configure an alarm banner that provides a 
visual representation of the alarm status.

1. In FactoryTalk View Studio, open the display name based on
the following:
• Single monitor — The name of the display is

(FRAME) P2f Header_1Mon
• Four-monitor — The name of the display is

(FRAME) P2f Template Alarm HButtonBar_4Mon

2. To access the Alarm and Event Banner Properties dialog box,
double-click in the icon bar.
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3. In the Event Subscriptions tab, click Browse (ellipsis …). 

The Select Scope window appears.

4. Click Process01 and click OK. 
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5. To use the scope defaults on the Alarm and Event Banner Properties 
dialog box, click OK. 

Once configured, the alarm banner appears as shown in the example. 
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Alarm Sounds

Complete the following steps to configure sounds that provide an audible alert 
for an alarm.

1. Repeat step 1 and step 2 on page 75.

2. Click the States tab. 

3. Check the desired sound actions in the Sound column and click 
Configure Sounds. 

The Alarm Sound Configurator dialog box appears.

4. For each alarm priority, select a sound file from the pull-down list.

IMPORTANT We recommend that you change the default beep to different 
sounds according to the alarm priority. The default beep is the 
sound that your local computer generates.
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5. When you are finished selecting sound files, click OK.

Your configured Alarm Sound Configurator dialog box looks similar to 
the following figure.

If necessary, it is possible to send sound information to the controller to 
create a control for a physical horn that can be configured in the 
Status Tags tab.
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View an Alarm Summary Complete these steps to view alarms in Summary mode.

For more HMI template information, see the Rockwell Automation
Library of Process Objects: Configuration and Usage Reference Manual, 
publication PROCES-RM002.

1. In the FactoryTalk View Studio software tree, open 
PlantPAx>Area>PlantPAx_HMI>Graphics>Displays>(FRAME) P2f 
Template Alarm-Summary. 

2. Double-click in the summary object.
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The Alarm and Event Summary Properties dialog box appears.

3. In the Event Subscription tab, click Browse (ellipsis “…”) under the 
Scope text box. 

The Select Scope dialog box appears.
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4. Select Process01 and click OK.

The Alarm Summary dialog box appears.
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Configure an Alarm Log 
Viewer

You can view and print alarm history databases from the Alarm and Event log. 
Complete these steps.

1. In the FactoryTalk View Studio software tree, open 
PlantPAx>Area>PlantPAx_HMI>Graphics>Displays>
(FRAME) P2f Template Alarm-HistoryDisplay. 

The Alarm and Event Log Viewer Properties dialog box appears.

2. Double-click in the (FRAME) P2f Template Alarm-HistoryDisplay 
object.

The Alarm and Event Log Viewer Properties dialog box appears.

3. On the Display Filters tab, click Add and type the name of the filter 
(Process01 in the example).

4. Select a group and click Add Where Condition.

The Filter Wizard dialog box appears.

5. Select a 'Where <Group>' from the pull-down list (Contains in the 
example).

IMPORTANT For more HMI template information, see the Rockwell Automation
Library of Process Objects: Configuration and Usage Reference Manual, 
publication PROCES-RM002.
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6. Click Browse (‘…’ ellipse) and select a group name (Process01 in
the example). 

7. On the Application window, click the Program pull-down arrow.

8. Select a program (Process01 in the example) to view the alarm log.

You can also configure global objects to filter and announce alarms by 
alarm group. The objects are in the Rockwell Automation Library of 
Process objects.

9. To filter by alarm group, complete these steps.
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a. From the Alarm Objects in the Library global objects folder,
drag-and-drop the Alarm object onto the Navigation screen.

b. Right-click the global object and choose Global Object
Parameter Values.

The Global Object Parameter Values dialog box appears.
c. For the #101 parameter, type the Alarm server name.
d. For the #102 parameter, type the Level 1 Alarm group name.
e. For the #103 parameter, type the Level 2 Alarm group name
f. If necessary for the #104 parameter, type the Level 3 Alarm

group name
g. Click OK.
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View Alarm System 
Configuration

The System folder includes the L_CPU instruction and the L_ModuleSts 
alarming. Complete these steps to view the alarm system.

1. In the Application tree, open the Area program and choose 
Alarm>PlantPAx_AE.

2. Double-click Alarm and Event Setup. 

3. Click Diagnostics to view information that has been automatically 
generated.

If you are using L_StsModule, the Alarm Builder Tool, by default, 
creates and populates a system alarm summary.
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Configure Historian Data Collection

Possessing the right information at the right time is critical for decision 
making. FactoryTalk® Historian software captures data for reports to help 
maximize plant-floor objectives and productivity. The software uses historical 
points (tags) in the system to produce analytical data. 

Analytical data includes process variables, trends, estimations, and
statistical reporting.

Considerations: Consider the following suggestions before starting this chapter:
• Perform any necessary configurations that are contained in the

PlantPAx Distributed Control System Infrastructure Configuration
User Manual, publication PROCES-UM001.

• The procedures in this chapter use the ‘System Management Tool’ and 
PI System Explorer within FactoryTalk Historian software. The tool is 
available for Historian Asset Framework management computers, such 
as server, node interface, and EWS.

• Microsoft® Excel® software is required to enable the bulk editing 
capability. An additional license is required to use PI Datalink.

IMPORTANT This chapter includes procedures for how to manually create Historian tags,
digital states, and Asset Framework. We recommend using the PlantPAx® 
Configuration Tool (see page 122) for creating bulk tags for large
process systems.
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Figure 6 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 6 - FactoryTalk Historian SE Workflow

Start

Create Digital States

See page 97

Define Historical Points

See page 102

Configure I/O ModulesSee Chapter 5

Import Digital States

See page 99

Import Asset Framework Templates

See page 109

Create Historian Points

See page 89

Search Event Frames

See page 115

Configure Asset Framework Elements

See page 113

PI Builder Bulk Editing

See page 105

PlantPAx Configuration Tool

See page 122

• Configure Asset Framework Server
• Create Historian Tags by Using PlantPAx Configuration Tool
• Verify Asset Framework Library and Elements

• Using the Template

• Finding Faults for Analysis
• Event Frames Reports (PI Builder)
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Create Historian Points Complete these steps to create historian points by using the FactoryTalk® 
Administration Console.

1. Click Rockwell Automation® software and choose FactoryTalk 
Administration Console.

2. Select the network for the type of FactoryTalk directory.

3. In the Explorer pane, right-click an application (PlantPAx is our 
example) and choose Add Individual Historian Points. 

4. On the Add Historian Points dialog box, click Browse Tags. 

Use an Engineering Workstation 
or a Historian server with these 
procedures.

EWS01 or ASIH01A
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5. In the Tag Browser window, select an object tag (TT01001 in the 
example) in the Folders pane on the left side of the window. 

6. In the pane on the right side of the Tag Browser window, double-click 
the tag to configure as a Historian Point.

Val (Process Variable Value) is the example.

7. Click Add Tags to List and click OK.
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The Add Historian Points dialog box reappears with a list of
selected tags.

8. Click OK.

FactoryTalk Historian uses System Management Tools (SMT™) to create 
and maintain historical points. You must have the proper historian 
server connection.

9. Choose Rockwell Software®>FactoryTalk Historian SE>
System Management Tools.

10. In the Servers Pane (or the Servers and Collectives pane if you have a 
collective), select the Historian server.
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11. In the System Management Tools pane, select Point Builder. 

12. Click the Search  button.
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13. In the Tag Search window, type the Tag Mask and click Search.

The tag appears on the Tag Search window.

14. Select the tag and click OK.

The point name and entire path appear on the Point Builder window.

To opt for a shorter point name, continue with the next step; otherwise, 
go to step 17. 

* = Wild Card
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15. Select the tag and click Rename.

16. In the Rename PI Point window, type a new name and click OK. 

17. In the General tab of the Point Builder dialog box, type a tag description 
and engineering units.
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18. Click the Archive tab to configure the range (Zero and Span), typical 
value, and all exception and compression data for the historical point. 

19. Click the Classic tab to view the historical tag path (instrument tag) that 
includes the Data server name.

Our example has the FactoryTalk Linx name, PlantPAx_DAT.
The historical point link is broken if any change is made to the 
FactoryTalk Linx application name. 

IMPORTANT Usually, Minimum Range Value = Zero, Span = Maximum Range 
Value minus Minimum Range Value. The Typical Value is between 
the Minimum Range Value and the Maximum Range Value.
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20. To monitor the last historical data, select Current Values and click the 

Search  tool. 

21. In the Tag Search window, type a tag mask or "*" for all tags, and click 
Search.

A tag list appears on the Tag Search window.

22. Select any tags that you wish to monitor and click OK.

23. To see values change as they periodically refresh, click the ‘Play’ button.
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Create Digital States Historian points can be defined as analog or digital. Digital points can be used 
to enumerate the process states, thus creating a relationship between the value 
and the text state name. For example: 1 = Good.

1. Using SMT with the proper historian server connection, select Digital 
States and click Add a Digital Data Set.

As an example of how to create your own Digital Data Set, review 
Table 3.

Add a Digital Data
Set Button

Table 3 - Source Quality Data Examples

Parameter Data Type Description

SrcQ SINT Final PV source and quality.
GOOD 0 = I/O live and confirmed good quality 

1 = I/O live and assumed good quality 
2 = No feedback configured, assumed good quality 

TEST 8 = Device simulated 
9 = Device loopback simulation 
10 = Manually entered value 

UNCERTAIN 16 = Live input, off-specification 
17 = Value substituted at device/bus 
18 = Value substituted by maintenance (Has and not Use) 
19 = Shed, using last good value 
20 = Shed, using replacement value 

BAD 32 = Signal failure (out-of-range, NaN, invalid combination) 
33 = I/O channel fault 
34 = I/O module fault 
35 = Bad I/O configuration (for example, scaling parameters) 
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2. Type a Digital Set name (SrcQ in the example).

3. Type a state name as shown in the Description column of Table 3.

New rows are automatically added as information is entered.

Unused values can be Undefined states. 

4. Save your changes.
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Import Digital Sets and 
States

Instead of manually entering Digital Sets and States, use Process Objects to 
import them.

The Digital Sets and States are available from the Historian folder in the 
Process Library. The Historian information is in a subfolder (Tools & Utilities) 
of the Files folder in the Process Library download.

Complete these steps.

1. Using SMT with the proper historian server connection, click
Digital States.

2. Click the Import button. 
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3. From the Import Digital Set(s) dialog box, click the folder icon.

4. Select a .CSV file from the dialog box.

5. Click Open.

6. Click Create Set(s).
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A minimum number of the recommended Digital Sets is created. This 
procedure does not create the basic Digital Set file for all Process 
Objects digital states.

7. Click Close.
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Define Digital Historical 
Points

The digital set is available only to a digital points type. The FactoryTalk 
Administration Console automatically creates a Float32 (Real) point type for 
each new point. 

This section shows how to change the point type. 

1. To be able to change the digital set, select Digital from the Point 
type pull-down.

IMPORTANT Before continuing with this section, it is necessary to include the 
Digital Historical point such as SrcQ (see step 1 on page 89 through 
step 11 on page 92).
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2. Click the Digital set pull-down menu and select a Digital Set (SrcQ in 
the example). 

3. Click the Save  icon to store the Historian point.
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4. Click Current Values and search for our tag to view the Digital set value 
corresponding to the point value. 
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PI Builder Bulk Editing The PI Builder spreadsheet provides for bulk tag editing. Complete the 
following steps. 

1. Open the Microsoft Excel software.

2. Click PI Builder and choose PI Points>Find PI Points. 

The Tag Search dialog box appears.

3. Type an object between the asterisks (*TT01001* in the example) and 
click Search.

The asterisks are a wild-card search that finds all tags associated with
the object.

4. Click OK.

IMPORTANT Before starting this section, PI Builder must be configured as a Microsoft 
Excel add-in. See the Excel add-in subsection in Chapter 9 of the PlantPAx 
Distributed Control System Infrastructure Configuration User Manual,
publication PROCES-UM001.
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5. Click OK to use the default for the objects types and column headers on 
the spreadsheet.

The spreadsheet populates information under the respective
default headings.

6. Click Close.
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7. Change your configuration or duplicate the point.

8. Click Publish.

9. Click OK to print the information on the spreadsheet.

10. Click Close.

Using the Template

Rockwell Automation provides a Historian template inside the Process Library 
that shows suggested points that can be used as digital Historian points. To 
access the Library folder that contains the template, see page 99.

You can select the object points ('x' in the Select(x) column next to the desired 
point) and edit them according to your needs.
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The Export Tags functionality is available to create, edit, or delete
Historian points.
108 Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019



Configure Historian Data Collection Chapter 4
Import Asset Framework 
Templates

Complete these steps to import templates for Asset Framework, which 
provides a means to organize your process equipment assets. We provide Asset 
Framework templates with the download of the Rockwell Automation
Library of Process Objects.

1. To open the Asset Framework server, click Programs>Rockwell 
Software®>FactoryTalk Historian SE>System Explorer (64-bit).

2. Click Yes to create a user database.

3. Type the name of the user database and click OK.

The PI System Explorer dialog box appears.

IMPORTANT Steps 2 and 3 are
necessary only the first
time that you name
a database.
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4. Click Library in the lower, left pane.

5. Right-click the database name and choose Import from File.
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6. Click Browse (ellipsis ‘…’) in the Import From File dialog box.

7. Browse in your system files to the (RA-LIB) 
AssetFramework_Templates .xml and click Open.

8. Click OK and Close.

IMPORTANT The Asset Framework templates are included in the Historian files 
with the Rockwell Automation Library of Process Objects download.
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The database now contains the Library object templates.

Objects
112 Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019



Configure Historian Data Collection Chapter 4
Configure Asset Framework 
Elements

Complete these steps to associate the tags with Historian elements, which are 
the Process object templates.

1. Click Elements in the lower, left pane of the PI System Explorer
dialog box.

An Element tree appears in the top, left pane.

2. Right-click Element and choose New Element.

TIP The term ‘element’ is used in the Asset Framework software.
For PlantPAx system purposes, ‘element’ can be considered 
synonymous with ‘objects’ in the Rockwell Automation Library
of Process Objects.
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3. Select P_AIn and click OK.

4. Type the tag that is being assigned to the object, such as P_AIn.

5. Click Check In.

6. Click Check In again.

The current historical value is accessed from the Attributes tab.
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7. Click the Attributes tab.

8. Click the Refresh button .

Search Event Frames Complete these steps to search for event frames. Abnormal conditions trigger 
an event, with date, time, and duration of the event.

1. Click Elements in the lower, left pane.

2. Click the Analyses tab on the PI System Explorer dialog box.
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The same fault information is available from Analyses in the lower,
left pane.

Finding Faults for Analysis

Complete these steps to search for event frame events to assess faults.

1. Click Event Frames in the lower, left pane of the PI System Explorer 
dialog box.
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2. Right-click Event Frame Searches and choose New Search.

3. Select the desired search criteria and any filters.

4. Click Search.

The search results for the selected criteria appear at the bottom of the 
dialog box.
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5. Click OK.

6. To view elements (tags) that are associated with the fault for the selected 
search criteria, double-click a fault.

7. Click the Referenced Elements tab.

Each tag (and description) that is assigned to the element appears.

Symbol shows duration of fault by length of the line.
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8. To view a description of the abnormal condition, click the
Attributes tab.

Event Frames Reports (PI Builder)

This section describes how to generate reports by using the information that is 
collected from the Event Frames (PI Builder spreadsheet).

1. Open the Template_ProcessObjects spreadsheet, which is included in 
the download with the PlantPAx Library of Process.

2. Select the PI DataLink tab and click Explore.

IMPORTANT The PI Datalink tool used in this section is optional and requires a license.
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3. Click the Add button to add an attribute.

4. Click the desired additional attribute.

5. In the bottom, right pane, select the desired ‘Columns to display’ ans 
click Apply.
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The events under the filter section appear in the report array.
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PlantPAx Configuration Tool The tool is used for creating tags in Historian based on the Asset Framework 
model. The procedure assumes that the tool is installed after being 
downloaded from the Rockwell Automation Library of Process Objects.

Configure Asset Framework Server

For optimum tool performance, you must make sure that the Asset Framework 
server is configured as described in this section.

1. To open the Asset Framework server, click Programs>Rockwell 
Software>FactoryTalk Historian SE>System Explorer (64-bit).

2. In the PI System Explorer, click File and choose Connections.

The Servers dialog box appears.

3. Right-click data collective (ASIH01) and choose Properties.

The Properties dialog box appears.
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4. Rename or configure this connection as necessary for your system.

5. Click OK.

6. Right-click asset server (ASIS01) and choose Properties.

The Properties dialog box appears.

7. Rename or configure this connection as necessary for your system.

8. Click OK.
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Create Historian Tags by Using PlantPAx Configuration Tool

This procedure assumes that the controller, HMI server, and the alarm server 
are configured for using the PlantPAx Configuration Tool. For tool 
configuration procedures, see the documentation that is supplied with the tool. 
The tool is contained in the download with the Rockwell Automation Library 
of Process Objects.

1. Open the PlantPAx Configuration Tool.

2. Right-click Historian Servers and choose Add Historian Server.

The Add Historian Server dialog box appears.

3. Type the name of the Historian server and click OK.

The Select Controllers dialog box appears.
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4. Type the server or collective name and select applicable controllers.

5. Click OK.

6. In the left pane, right-click the Historian server that you just created 
(Production Historian in our example), and choose Import to Asset 
Framework (AF) Database.
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In the right pane, the Build Tags Setup window appears.

7. Click Connect.

8. Click OK twice.
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The Build Tags window reappears.

9. Click Options.

The FactoryTalk Historian Import File Builder Options
dialog box appears.
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The option, if selected, adds the controller name as a prefix to Historian 
tags. For example, LGXC01.<tagname>. 

For our example shown, the option is not checked. Therefore, the 
controller prefix is not included in the Historian tag names.

10. Close the FactoryTalk Historian Import File Builder Options
dialog box.

11. In the right pane, click the Build Tags Information tab.

Review the information.

12. Click the Build tab.

13. Click the Build button.
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14. Click OK.

The build process completes.

15. Close the PlantPAx Configuration Tool.
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Verify Asset Framework Library and Elements

After using the PlantPAx Configuration Tool, you must verify that the Asset 
Framework library and elements are properly imported into the Asset 
Framework database.

1. To open the Asset Framework server, click Programs>Rockwell 
Software>FactoryTalk Historian SE>System Explorer (64-bit).

The PI System Explorer window appears.

2. Click the Library folder.

3. Verify the contents of the library.
130 Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019



Configure Historian Data Collection Chapter 4
4. Click Elements.

5. Verify the elements.

6. Close the PI System Explorer.
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Notes:
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Chapter 5

Configure I/O Modules

The PlantPAx® system features flexible, intelligent I/O instrumentation to 
maximize production and reduce downtime. This chapter describes
basic techniques for configuring plant-wide communication via I/O modules.

The ControlLogix® system is chassis-based and provides the option to
configure a control system that uses sequential, process, motion, drive control, 
deterministic, and I/O capabilities. Ethernet remote I/O modules transmit 
end device feedback to controllers. The data includes diagnostics, temperature 
measurement, and counter-inputs for process control.

Procedures in this chapter describe how to configure the devices that are shown
in Figure 7. 

Figure 7 - Example of PlantPAx Distributed I/O Modules

Supervisory Network
Control Network

I/O Network

Safety Network

Trunk - (Native)

Management
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Figure 8 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 8 - I/O Infrastructure Workflow

Start

Add Remote I/O Chassis

See page 135

Configure Redundant I/O Modules

See page 169

See Chapter 6 Assign I/O and Diagnostics

 Add a Stratix® Switch Connection

See page 174

Configure I/O Modules

See page 138

Add Diagnostics

See page 177

• 1756 Analog Input Module
• 1756 Analog Output Module
• 1756 Digital Input Module
• 1756 Digital Output Module
• 1756 Low-speed Counter Module
• Process I/O Linking Devices
• Motor Control Center Components
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Add Remote I/O Chassis This section describes how to add a remote I/O chassis and configure a ring 
supervisor, if applicable. Make sure that the chassis size matches the installed
rack size.

Complete these steps in Logix Designer.

1. In the I/O Configuration tree, right-click the remote I/O network 
under the adapter and choose New Module.

2. In the Catalog tab of the Select Module Type dialog box, select a 
network adapter and click Create.

Use an Engineering Workstation 
with these procedures.

EWS
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3. On the New Module dialog box, type a module name and set an
IP address.

4. Click Change.

5. On the Module Definition dialog box, do the following.

a. See step 6 for the Rack Connection.
b. In the Time Synch Connection pull-down, select Time Synch

and Motion.
c. In the Chassis Size pull-down, select a value for the number of chassis 

slots for this remote chassis.
d. Click OK.
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6. If you use a rack connection as ‘Rack Optimization’, make sure to 
configure the proper Requested Packet Interval (RPI) under the 
Connection tab.

If you are not using a rack option, you have to set an RPI for each device.

7. Click OK to change the module definition.

8. Click OK again to add the module.

9. To add additional network adapters, repeat step 1 through step 7.

See Configure I/O Modules on page 138 for how to add analog and 
digital I/O modules.

IMPORTANT The option ‘Use Unicast Connection over EtherNet/IP’ defaults. For a 
redundant controller, you must disable this option.
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Configure I/O Modules A wide range of I/O modules can be used with smart devices and motors for 
process control in the PlantPAx system. This section describes how to 
configure analog and digital I/O modules.

Procedures in this section use preferred PlantPAx I/O network modules with 
example settings for ControlLogix, HART, Process device, and motor
control modules.

Logix5000™ controllers can be configured with local and remote I/O modules
in multiple networks.

Figure 9 - Example of I/O Network Modules

For color legend, see page 133.

Field Devices

Primary Controller Secondary Controller

1715 Redundant I/O ControlLogix® I/O
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1756 Analog Input Module

After you create a Logix Designer application and add a communication 
module to the project (see page 135), complete the following steps to create a 
module in the project.

This procedure shows how to add an 8-channel isolated HART analog input 
model to a 1756 ControlLogix controller.

1. In the Controller Organizer of a Logix Designer application, right-click 
the remote I/O backplane and choose New Module.

The Select Module Type dialog box appears.

2. With the Category tab selected, click the box for each module type (in 
the top left filters box).

ControlLogix analog I/O modules are 
interface modules that convert 
analog signals to digital values for 
inputs. Conversely, the modules 
convert digital values to analog 
signals for outputs. Controllers use 
these signals for control purposes.
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The Analog box is checked in our example so analog modules are our 
selection choices in the middle of the dialog box.

You can also sort by vendor in the top right filter box.

A Logix Designer application also gives you an option to select available 
modules when you are online in the system. The Module Discovery tab 
lists modules that the Logix Designer application automatically detects 
on the backplane.

3. If online, select a module and click Create.

The New Module dialog box appears.

4. On the General tab, do these steps:
a. Type a name for the module.
b. Type a description for the module.
c. Select the slot number for the module.

TIP If you are offline, in the Catalog tab of the Select Module Type dialog box, 
select an analog module and click Create.
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5. In the Module Definition box, click Change.

The Module Definition dialog appears.

6. Complete the following actions.

7. Click OK.

A warning message asks you to confirm changes to the module 
definition.

8. Click Yes.

Parameter Action Values

Connection From the pull-down menu, 
select a connection type.

• Data - has more tabs on the 
Module Properties dialog box 
than Listen-only because of 
configuration settings for alarms, 
calibration.

• Listen-only - has no 
configuration data, does not send 
output data.

Input Data From the pull-down menu, 
select a data input mode.

• Analog Only
• Analog and HART PV
• Analog and HART by Channel
For details, see the ControlLogix 
HART Analog I/O Modules User 
Manual, publication 1756-UM533.

Configure HART Device Select whether to enable the 
Configure HART Device feature. 
This feature is available only for 
the 1756-IF8IH and 1756-OF8IH 
modules when data format is 
Analog and HART by Channel. If 
you select Yes, a HART Command 
tab is added to the configuration 
dialog, in which you specify 
configuration values to be sent 
to the HART device.

Values that can be added in the 
HART Command tab are PV Damping 
(seconds), PV Units, PV Upper 
Range, PV Lower Range, PV Transfer 
Function.

Coordinated System Time Not configurable. Timestamped.

Data Format Not configurable. Float.
Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 141

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-um533_-en-p.pdf


Chapter 5 Configure I/O Modules
9. Click the Connection tab.

10. In the RPI box, type a value to specify a time interval when the data is 
sent to the controller.

11. Leave the default checkbox ‘Use Unicast Connection over EtherNet/IP’.

Enable HART Channel Data

Complete these steps to configure each channel for HART data.

1. Click the Configuration tab.

2. Check Enable HART for each applicable channel and click OK to 
create the module.

We recommend that you Enable HART for any channel that has a 
connected HART device. The information is displayed on the HART 
Device Info tab and accessed by FactoryTalk® AssetCentre software.

IMPORTANT An RPI that is set too fast can affect controller performance. We 
suggest that you specify an RPI that is two times faster than task 
execution or based on inherent properties of the signal being 
measured. For example, a 250 ms task requires a 125 ms time, but 
temperature measurements can be set slower as they are unlikely to 
change that quickly.

IMPORTANT The Unicast checkbox must be disabled (no check mark) for a 
redundant controller.

See Appendix A for NAMUR standard 
value ranges depending on module.
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You can check Enable HART on channels that have HART field
devices attached.

3. If online, reopen the module properties dialog box and click the HART 
Command tab to specify HART device parameters for each channel. 
These values are sent to the HART device.

4. Click ‘Enable HART Device PV Range Configuration (Command 35, 
Command 47)’.

5. Set a range for the highest and lowest values for the PV in the specified 
engineering units.

6. Click Apply.

IMPORTANT If you enable the HART device for a PV range, the functionality 
provides a continuous update of the variables. The data is exposed 
as tags in the I/O module. If you do not want a continuous update of 
the variables, remove the check in the ‘Enable HART Device PV 
Range Configuration’ box.
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7. Click the HART Device Info tab.

8. Click Set Device Info.

The Set Device Info button is enabled when the controller is online.

9. Type a tag name, message, and descriptor for the HART device on the 
selected channel and click Set.

This information is sent to and stored in the HART device.

10. Click OK.
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1756 Analog Output Module

This section describes how to enable output parameters for a 1756-OF8IH 
analog module.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 139…142.

The example shows a naming convention for the 1756-OF8IH
analog module.

2. Click the Output State tab.

The dialog box is divided into four sections: 
• Ramp Rate
• Output State in Program Mode
• Output State in Fault Mode
• Communications Failure
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3. With an individual channel button selected, use the information in
Table 4 to configure the parameters.

Proceed to Enable HART Channel Data on page 147

Table 4 -  Output Parameter Configuration

Select Transitions

Ramp in Run Mode (Parameters available in Hard Run mode)

Ramp Rate Check the box and type a value to limit the speed at which an 
analog output signal can change. This option helps prevent fast 
transitions in output from damaging equipment that the
output controls.

Output State in Program Mode (Parameters not available in Hard Run mode)

Hold Last State Click to leave the current output at its last value.

User-Defined Value Click and type a specific value to use when the owner controller is 
switched into Program mode. Value range is from
-9,999,999…99,999,999, default is 0.

Ramp to User-Defined Value If Hold Last State – This field is disabled.
User-Defined Value – Check if you want the output to ramp to the 
user-defined value at the specified ramp rate. 
If unchecked, output signal steps to the User-Defined Value 
immediately when you enter Program mode.

Output State in Fault Mode (Parameters not available in Hard Run mode)
Module enters Program mode state if the Connection from Logix is inhibited. If communication later fails, 
all channels of the module remain in Program mode.

Hold Last State Click to leave the output signal at its last value.

User-Defined Value Click and type a specific value to use if a fault occurs. Value range is
-9,999,999…99,999,999, default is 0.

Ramp to User-Defined Value If Hold Last State – This field is disabled.
If User-Defined Value – You can check this option if you want the 
output to ramp to the user-defined value at the specified ramp rate.
If unchecked, the output signal steps to the user-defined value 
immediately when you enter Fault mode.

Communications Failure
If communication fails while in Run mode, the output signal goes to its Fault mode state. If 
communication fails while in Program mode, the output signal behaves as follows.

Leave outputs in Program Mode 
state

Click to leave output signal at the configured Program mode value

Change outputs to Fault Mode 
state

Change output signal at configured Fault mode value if a 
communication fails (connection from controller breaks).
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Enable HART Channel Data

Complete these steps to set up each channel for HART data.

1. Click the Configuration tab.

2. Check Enable HART for each applicable channel.

We recommend that you Enable HART for any channel that has a 
connected HART device. The information is displayed on the HART 
Device Info tab and accessed by FactoryTalk® AssetCentre software.

3. Click OK to create the module.

4. If online, reopen the Module Properties dialog box and click the HART 
Device Info tab.
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5. Click Set Device Info.

The Set Device Info button is enabled when the controller is online.

6. Type a tag name, message, and descriptor for the HART device on the 
selected channel and click Set.

This information is sent to and stored in the HART device.

7. Click Set.

1756 Digital Input Module

This section focuses on how to configure individual points of the module for 
On/Off detection and actuation.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 139…142.

On the respective Select Module Type dialog box, choose a 1756-IB16D 
diagnostic module or a 1756-IB32/B module.

ControlLogix Digital I/O modules are 
input/output modules that produce 
information when needed by using 
the produce/consume model.
Digital modules also provide 
additional system functions, such
as system Time Stamp of data and
diagnostic detection.
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The diagnostic (‘D’) module has tabs for diagnostics output data
while the output module has only Output Data. The graphics are 
examples only.

2. On the Connection tab, select an RPI and click OK.
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3. Click the Configuration tab.

4. Do one of the following in the Enable Change of State columns:
• To enable COS for point range, check the corresponding Off to On 

or On to Off box.
• To disable COS for a point range, clear the corresponding Off to On 

or On to Off box.

5. Click OK.

6. Click the Points tab.

IMPORTANT Skip the next two steps if you are not using the Change of State 
functionality.
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7. Do one of the following in the Enable Change of State columns:
• To enable COS per point, check the corresponding Off to On or On 

to Off box.
• To disable COS per point, clear the corresponding Off to On or On 

to Off box

8. Click OK to create the module.
For more information, see the ControlLogix Digital I/O Modules User 
Manual, publication 1756-UM058.

1756 Digital Output Module

This section describes how to configure output states if the module goes into 
Program mode or Fault mode.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 139…142.

On the respective Select Module Type dialog box, choose a
1756-OB16D diagnostic module or a 1756-OB32 module.
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The diagnostic (‘D’) module has tabs for diagnostics output data
while the output module has only output data. The graphics are 
examples only.
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2. After you define the RPI on the Connection tab, click the 
Configuration Tab.

3. From the Program Mode pull-down menu, choose the module output 
state during Program mode:
• On
• Off
• Hold (Retain current output state)
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4. From the Fault Mode pull-down menu, choose the module output state 
during Fault mode:
• On
• Off
• Hold (Retain current output state)

5. Click OK.

For more information, see the ControlLogix Digital I/O Modules User 
Manual, publication 1756-UM058.

1756 Low-speed Counter Module

This section describes Configuration tabs so the counters can count pulses 
from devices such as proximity switches and photoelectric sensors. The counts 
are presented as an accumulated count or frequency.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 139…142.

On the respective Select Module Type dialog box, choose a 
1756-LSC8XIB8I module.

2. After you define the RPI on the Connection tab, click the 
Configuration Tab.

You can associate hardware inputs of the module to the counters.

The low-speed counter module is 
used in Process applications to save 
controller bandwidth. The module 
can be used as a pulse totalizer
for flowmeters or a speed sensor
in conveyors. 
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3. Select a counter to tie the counter control function to a standard
hardware input. 

The state of the external input device controls the designated counter

4. Check Invert to change the input count direction, if applicable.

5. Use the pull-down menus to choose the desired input filter times.

6. Click the Counter Configuration tab.

7. Click a counter to configure frequency per pulses.

8. Click OK to create the module.

For more information, see the ControlLogix Low-speed Counter 
Module User Manual, publication 1756-UM536.
Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 155

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-um536_-en-p.pdf


Chapter 5 Configure I/O Modules
Process I/O Linking Devices

This section shows how to configure Fieldbus Foundation and PROFIBUS PA 
linking devices to communicate field device information via Common 
Industrial Protocol (CIP™) networks to a Logix controller.

Complete these steps.

1. Right-click the network of the remote I/O, and choose New Module.

2. On the respective Select Module Type dialog box, choose a 
1788-EN2FFR (fieldbus) or 1788-EN2PAR (PROFIBUS) module.

3. Name the device and type an IP address.

4. On the Connection tab, set the RPI value and click OK.

For more RPI information, see the Important on page 142.

5. Click OK.

6. In the Controller Organizer, double-click the linking device.

These modules are referred to as linking 
devices because they provide a gateway 
between Ethernet and ControlNet 
networks to FOUNDATION Fieldbus and 
PROFIBUS PA networks.
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The Module Properties dialog box appears.

7. Click the Configuration tab.

Live List
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Once the linking device is connected to the controller, you can see the 
linking device in the Configuration tab.
• Master green in the configuration tree = linking device is online
• Master gray in the configuration tree = linking device is offline

For more information, see the following documents:
• EtherNet/IP™ and ControlNet® to FOUNDATION Fieldbus 

Linking Devices User Manual, publication 1788-UM057
• EtherNet/IP and ControlNet to PROFIBUS PA Linking Devices 

User Manual, publication 1788-UM058

Motor Control Center Components

This section describes how to configure MCC components, including 
PowerFlex® drive, SMC™, and overload relay examples.

PowerFlex 755 Example

Complete these steps.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

IMPORTANT This section shows how to configure the PowerFlex 755 drive. You can use 
basically the same procedures for configuring other PowerFlex drives.
The Datalinks must be configured before using the respective PowerFlex 
procedures. For Datalink information, see the following Rockwell 
Automation® Library of Process Objects Add-On Instructions:
• PowerFlex 755 (P_PF755), publication SYSLIB-RM040
• PowerFlex 753 (P_PF753), publication SYSLIB-RM044

Low-voltage motor control centers (MCC) 
house starters, soft starters, and drives as an 
alternative to wiring each device individually. 
Simplified programming creates a single 
network for complete machine control.
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2. From the Select Module Type dialog box, select a PowerFlex 755 module 
and click Create.

3. Type a name and IP address for the drive.

4. In the Module Definition section, click Change.
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The Module Definition dialog box appears.

5. Click Match Drive.

6. Click Full on the message window.
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7. Select the drive and click OK.

8. Click OK to the message that the online action is successful.

The Module Definition dialog box reappears with the input datalinks 
for the matching drive.

9. Click OK.

10. Click Yes to accept the module changes.

11. Click the Connection tab and set an RPI value.

12. Click OK to add the drive.

For more information, see the PowerFlex 750-Series AC Drives 
Programming Manual, publication 750-PM001.

PowerFlex 525 Example

Complete these steps.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

IMPORTANT This section shows how to configure the PowerFlex 525 drive. You can use 
basically the same procedures for configuring other PowerFlex drives.
The Datalinks must be configured before using the respective PowerFlex 
procedures. For Datalink information, see the following Rockwell 
Automation® Library of Process Objects Add-On Instruction:
• PowerFlex 523/525 (P_PF52x), publication SYSLIB-RM048
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2. From the Select Module Type dialog box, select a PowerFlex 525 module 
and click Create.

3. Type a name and IP address for the drive.

4. In the Module Definition section, click Change.

The Module Definition dialog box appears.

5. Click Match Drive.

6. Click Upload Entire Device.

7. Click OK after a review of possible changes to the module definition on 
a popup window.
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8. Click OK on the Module Definition dialog box.

9. Click Yes to accept the module changes.

10. Click the Connection tab and set an RPI value.

11. Click OK to add the drive.

For more information, see the PowerFlex 520-Series Adjustable 
Frequency AC Drive Programming Manual, publication 520-UM001.
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Smart Motor Controller (SMC-50) Example

Complete these steps to use a module that is designed to maximize the 
efficiency of motor starts and stops.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

2. From the Select Module Type dialog box, select an SMC-50 module and 
click Create.

3. Type a name and IP address for the motor controller.

4. In the Module Definition section, click Change.

The Module Definition dialog box appears.

5. Click Match Drive.

6. Click Upload Entire Device.

7. Click OK after a review of possible changes to the module definition on 
a popup window.

IMPORTANT This section shows how to configure the SMC™-50 smart starter. You can use 
basically the same procedures for configuring other motor starters.
The Datalinks must be configured before using the respective SMC™ 
procedures. For Datalink information, see the following Rockwell 
Automation Library of Process Objects Add-On Instructions:
• SMC-50 (P_SMC50), publication SYSLIB-RM052
• SMC™ Flex (P_SMCFlex), publication SYSLIB-RM053
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The Module Definition dialog box reappears with the input datalinks 
for the matching drive.

8. Click OK.

9. Click Yes to accept the module changes.

10. Click the Connection tab and set an RPI value.

11. Click OK to add the motor controller.

For more information, see the SMC-50 Solid-State Smart Motor 
Controller User Manual, publication 150-UM011.

E300™ Electronic Overload Relay Example

Complete these steps to add an overload relay that features a modular design 
and diagnostic information for motor control applications.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

IMPORTANT This section shows how to configure the E300 overload relay. You can use 
basically the same procedures for configuring other protection relays.
The Datalinks must be configured before using the respective SMC 
procedures. For Datalink information, see the following Rockwell 
Automation Library of Process Objects Add-On Instructions:
• E300 (P_E300Ovld), publication SYSLIB-RM051
• E1 Plus (P_E1PlusE), publication SYSLIB-RM049
• E3/E3 Plus (P_E3Ovld), publication SYSLIB-RM050
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2. From the Select Module Type dialog box, select an E300 relay module 
and click Create.

3. Type a name and IP address for the drive.

4. In the Module Definition section, click Change.
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The Module Definition dialog box appears.

5. Click Upload

6. Click OK on the popup window when the Upload completes.

7. Click OK again on the Module Definition dialog box.
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8. Click OK on the New Module dialog box.

For more information, see the Bulletin 193/592 E300 Overload Relay 
User Manual, publication 193-UM015.
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Configure Redundant I/O 
Modules

This section shows how to configure a 1715 redundant I/O system with a 
remote I/O chassis on an EtherNet/IP network. Using a ControlLogix 
controller, this redundant system provides fault tolerance with a redundant 
adapter pair and multiple I/O modules for enhanced diagnostics.

1. To set up a network adapter, right-click an Ethernet bridge in the I/O 
Configuration tree and choose New Module.

2. On the Catalog tab, use the filter to select a 1715 Ethernet adapter and 
click Create.

The 1715 redundant I/O platform offers 
flexibility, with no special wiring, and no user 
programming code or Add-On Instructions. 
The redundant I/O system requires less 
engineering because no additional hardware
is required.
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3. On the New Module dialog box, type a name for the adapter and set an
IP address.

4. Click the Connection tab and select an RPI value.

5. Click OK to add the module.

6. Right-click the new 1715 adapter and select New Module.
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7. Select a 1715-IF16 analog input module, click Create, then name
the module.

8. Assign a slot number.

9. Click the Configuration tab to check the channel signals.

10. Click OK to add the module.
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11. Repeat step 7 through step 9 to create a 1715-OF8I analog
output module.

12. Click OK.

13. Repeat step 7 through step 9 to create a digital diagnostic
input (1715-IB16D) module.
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14. Click OK to add the module.

15. Repeat step 7 through step 9 to create a digital diagnostic
output (1715-OB16DE) module.

16. Click OK to add the module.

All 1715 I/O modules are added to the remote I/O chassis.

For more information, see the Redundant I/O System User Manual, 
publication 1715-UM001.
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Add a Stratix Switch (CIP) 
Connection

Complete these steps to configure a managed switch to leverage ports for 
sending messages only to the device that needs or requests the communication.

1. Right-click on an Ethernet adapter and choose New Module.

The Select Module Type dialog box appears.

2. Select a Stratix managed port adapter and click Create.

IMPORTANT A CIP™ VLAN must be enabled for the switch to perform the following steps. 
To enable CIP, see Chapter 1 in the PlantPAx Distributed Control System 
Infrastructure Configuration User Manual, publication PROCES-UM001.

IMPORTANT The Stratix 5410 is accessed via the Managed Ethernet Switch 
category filter. Other switches are accessed by using the 
Communication category type.
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3. On the New Module dialog box, type a module name and assign an
IP address.

4. Click Change and select a Connection type ‘Data’.

5. Type a password and click OK on the Module Definition dialog box.

6. Confirm the password and click OK.

The New Module dialog box reappears.
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7. To enable a redundant power supply, if applicable, click ‘Enable
Dual Power Supply Alarm’ on the switch configuration for the
module properties.

Repeat step 1 through step 7 to configure all of your system switches.

A list of switches appears in the Controller Organizer.

For more information, see the Stratix Managed Switches User Manual, 
publication 1783-UM007.
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Add Diagnostics This section describes how to add diagnostics to an I/O module. Complete
these steps.

1. In the Logical Organizer, open the Controller Task folder.

2. Right-click Diagnostics and choose Add>New Routine.

The New Routine dialog box appears.

3. Type a routine name and click OK.

IMPORTANT Controller Status is among nine predefined periodic tasks in the controller 
template. A diagnostics folder is within the Controller Status periodic task.

IMPORTANT For a remote rack, include one routine per rack. Each rung is to 
contain one Module_Sts. For an MCC, include one routine for each 
MCC device.
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4. In the Diagnostics folder, double-click the LCPU routine to access a 
ladder logic.

5. Click the last rung, type JSR and press Enter.

6. Click the routine name box inside the JSR command, and select the 
routine name that you created.

7. Double-click the routine that you created to access a ladder logic.

8. Right-click the rung and choose Import Rungs.
178 Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019



Configure I/O Modules Chapter 5
9. Browse to the Process Strategies folder and select the Module Status 
process strategy.

10. Click Open.

11. On the Import Configuration dialog box, click the Find/Replace button 
to replace the default module tag with your device.

12. Click Replace All.
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13. Repeat step 11 and step 12 to replace ‘TagDescript’ with your own 
description (EtherNet/IP 02 is the example).

14. Click Replace All.

15. Click Close, and then click OK to import the routine.

16. Repeat step 7 through step 15 for all modules in the I/O configuration.

This example shows that the routine rungs align with the I/O tree 
configuration.

17. Save your work.
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Assign I/O and Diagnostics

After you have defined your I/O modules and built the process strategies, you 
must connect the I/O definition to a physical device. This chapter describes 
how to assign the I/O tags.

When we assign I/O, we are creating a relationship between process strategies 
and the device. The I/O module is connected to the tags of the process 
strategy. 

This chapter illustrates the following three program examples:
• An analog input channel with diagnostics
• An MCC device that uses a COP instruction to transfer raw data
• Analog input tags assigned to connectors within a PID loop

Typically, you can use the basic analog input procedures in the first example to 
assign I/O tags to devices. The other two examples have additional 
requirements, such as the creation of programs and routines for drives because 
of differing data types.
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Figure 10 contains the topics that are described in this chapter. Click or see 
the page number for quick access to a section.

Figure 10 - Assign I/O Workflow

Start

Connect Analog Input Channel with Diagnostics

See page 183

Connect an MCC Device

See page 187

Connect a PID Loop

See page 197

See Chapter 7 Configure Asset Management Tools

• Create Routines
• Assign Diagnostics
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Connect Analog Input 
Channel with Diagnostics

This section shows how to connect I/O to the analog input channel process 
strategy (PS_AIn_Chan). Complete these steps.

1. In a Logix Designer application, open an existing program.

2. Double-click Parameters and Local Tags under the Area01>Logic and 
Tags folders. 

3. Click the Edit Tab (at the bottom of the screen), then right-click a 
column header.

4. Click Toggle Column and choose Connections. 

The process strategy tags that appear in the Edit Tags tab
show connections. 

See Build Process Strategies on page 32.

IMPORTANT The first time that you perform this procedure, the Connections 
column is not visible. Complete step 3 to show the Connections 
column.
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5. In the Connections column, click the pull-down to display a list of 
I/O tags for the Inp_Raw Process Strategy.

The tag names can be broken down into the remote module, slot 
number, and I/O module. 

The first letter in the I/O Module Data represents the type of I/O the 
tag is:
• I = Input
• O = Output
• C = Configuration

Remote I/O Adapter

Slot Number
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6. Click a data tag (LGXC01EN02R01:1:l.Ch0.Data) in the example) to 
place the tag in the Connections text box.

7. To place the tag in the Connections text box, click an I/O tag. 

8. Repeat step 5 through step 7 to assign a Fault tag to the 
Inp_Raw_ChanFault Process Strategy.

9. For the Module input fault (Inp_Raw_ModFault) Process Strategy, 
select Diagnostics from the Show parameters from other program pull-
down. 

Local Process Strategy Tags
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10. Click the Connections pull-down and double-click an
I/O diagnostics tag.

11. To view the connections, open the routine. 
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Connect an MCC Device Drives typically have different data types. You can create a program with 
specified input and output routines to send raw data to a compatible data type. 

Complete the following steps.

1. In a Logix Designer application, open an existing program.

2. In the Controller Organizer, right-click a task and choose 
Add>New Program. 

The New Program dialog box appears.

3. Type a program input name.

Our example (EtherNetIP_Inputs_D) has an _D because we created our 
program from the Task_D_500ms folder. When you create programs 
from different tasks add an _x, with ‘x’ to denote the letter of the 
selected Task folder.

For example, EtherNetIP_Inputs_C if this routine were to be used in the 
Task_C_250ms task.

4. Click OK.
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5. Repeat step 2 through step 4 and type a program output name.

6. To organize programs within a task, right-click the Task in the 
Controller Organizer and choose Properties.

The Task Properties dialog box appears.

7. Click the Program/Phase Schedule tab.

8. Click a program that you want to move and click the Up or Down 
arrows to move the program. Position the programs in the following 
execution order (top to bottom):
Input Process Strategies Output

9. Click OK.
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10. Click the Logical Organizer tab and drag-and-drop the Inputs and 
Outputs programs into the System folder. 

11. Save your work.
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Create Routines

Complete the steps to create routines for the programs.

1. On the Logical Organizer, right-click a Program and choose 
Add>New Routine.

The New Routine dialog box appears.

2. Type ‘MainRoutine’ (for a jump to subroutine) and select 
"EthernetIP_Inputs_D" in the pull-down for In Program or Phase.

3. Click OK.
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4. Repeat step 1 and step 2 for an EtherNetIP Inputs routine name.

We suggest that you create one routine for each network. This routine 
can contain all network adapters owned by this communication adapter.

5. In the Logical Organizer, right-click the EtherNetIP program name
and choose Properties.

6. On the Connection tab, select MainRoutine from the pull-down menu.

7. Click OK.

8. Repeat step 1 and step 2 for an EtherNetIP Outputs routine name.
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9. In the Logical Organizer, double-click MainRoutine of the
Input Program.

10. Double-click a rung, type JSR, and press Enter.

An instruction that is named 'JSR' is shown in the rung.

11. In the instruction, select the Routine Name that you created in step 2 
(MainRoutine in the example) from the pull-down list.

12. Repeat step 10 and step 11 for EtherNetIP_Outputs.

13. Under EtherNetIP_Inputs, open the LGXC01EN02 routine,
double-click the first rung, and type COP.

14. Press Enter.

A Copy instruction transfers raw data only and ignores data types. The 
instruction lets you use a compatible data type to connect the tags.

15. In the instruction, click the Source pull-down arrow to select a drive 
input from the list.
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16. In the instruction, click the Destination pull-down arrow and select a 
destination data tag (for example, MT01001_Inp). 

For MCC components, select the drive input that is created when 
importing process strategies for drives.

The destination data tag appears in the COP instruction.

17. In the instruction, type a Length of '1'. 
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18. Repeat step 13 through step 17 to tie the EtherNetIP_Outputs tag to 
the I/O.

19. If online, click the Finalize All Edits in Program  icon.

The Finalize all edits in program window appears.

20. Click OK to finalize edits in all programs.

21. Save the program.

IMPORTANT Observe that the Source and Destination are opposite for the COP 
output instruction.

IMPORTANT You must finalize EtherNetIP_Inputs, EtherNetIP_Outputs, and 
Process Strategies.
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Assign Diagnostics

Complete these steps to connect the process strategy tags to the I/O Module
(PowerFlex® 755 in our example).

1. In the Logical Organizer, open a program from the Process01 folder and 
double-click Parameters and Local Tags.

The program tags appear. 

2. Click the Edit Tags tab.

3. Assign the I/O and the diagnostics by using the program connections.

4. Click a data tag to place the tag in the connections text box.
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5. To view the connections, click one of the tags in the Logical Organizer. 
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Connect a PID Loop Complete the following steps to assign I/O to a PID loop.

1. In the Logical Organizer, open the Process folder and double-click 
Area01>Logic and Tags>Parameters and Local Tags.

2. Assign the I/O and the diagnostics by using the program connections. 

3. Click a data tag to place the tag in the connections text box.

4. Save your work.
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Notes:
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Chapter 7

Configure Asset Management Tools

This chapter describes how to use application tools available with the 
FactoryTalk® AssetCentre software.

For example, a Device Type Manager (DTM) contains Field Device Tool (FDT) 
compliant interfaces to enable configuration and communication between 
devices and the system. The interface helps create device parameters for 
diagnostics, maintenance, and calibration purposes.

Disaster recovery is another benefit of AssetCentre software. Back up master files 
of controller applications help to safeguard against a loss of data.

An Audit Log monitors FactoryTalk-related software products and logs user 
interactions. For details, see Chapter 10 in the PlantPAx® System Infrastructure 
Configuration User Manual, publication PROCES-UM001.

Considerations Consider the following suggestions before starting this chapter:
• We strongly recommend additional licensing for disaster recovery that 

automatically backs up supported devices.
• If you are using HART, Fieldbus Foundation, and/or PROFIBUS PA 

process devices, we recommend the DTM procedure, which starts on 
page 201. DTMs contain device-specific data to enhance configuration 
and communication with the system.

• Instrument calibration is an option with AssetCentre software.
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Figure 11 shows the topics that are described in this chapter. Click or see the page 
number for quick access to a section.

Figure 11 - AppServ-Asset Workflow 

Start

Use a DTM for Device Configuration

See page 201

Configure Disaster Recovery

See page 215

See Chapter 8

• Design for the Device

• Configure a Logon
• Add an Asset
• Create a Working Folder
• Create a Backup Schedule

Configure An Asset Inventory

See page 226

Configure System Diagnostics
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Use a DTM to Configure
a Process Device

This section describes basic Device Type Manager (DTM) configuration. Use the 
DTM with FactoryTalk AssetCentre to connect Process devices. You can perform 
this process in the AppServ-Asset server, but typically the engineering 
workstation is used to store software.

Complete these steps.

1. Click the Programs  symbol and choose Rockwell 
Software®>FactoryTalk AssetCentre Client>AssetCentre Client.

The AssetCentre Client window appears. 

2. Choose Tools>DTM Catalog.

The DTM Catalog window appears. 

IMPORTANT For procedures on how to configure the AppServ-Asset server, see
the PlantPAx Distributed Control System Infrastructure Configuration User 
Manual, publication PROCES-UM001.

Use an Engineering Workstation 
(preferred) or AppServ-Asset 
server with these procedures.

EWS01 or ASAM01
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3. Click Scan Now to update the catalog.

4. Click Close when the scan is complete.

5. In FactoryTalk AssetCentre software, click the Tasks tab and choose DTM 
Networks.

IMPORTANT Every newly installed DTM requires a scan.
If you do not have a new DTM installed, skip this step.
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The DTM Networks window appears.

6. Right-click Host PC>Add DTM.

The Add DTM window appears. 

The same procedure must be performed on PROFIBUS PA and Fieldbus 
Foundation modules. 

IMPORTANT The HART module must be configured in the I/O configuration tree.
For details to enable HART channel data, see Chapter 5.
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7. Select DTM 'RSLinx® 1756 Backplane (ControlLogix®)' and click OK

8. In the DTM Networks window, right-click '(RSLinx 1756 Backplane)' 
and choose Configuration.
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9. Select the path to the backplane.

The Select 1756-Backplane dialog box opens.

10. Select 'Backplane, 1756-A7/A or B' and click OK.
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11. In the DTM Networks window, click Next. 

12. In the DTM Networks window, right-click '(RSLinx 1756 Backplane)' 
and choose Add DTM. 
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The Add DTM window appears. 

13. Select DTM '1756-IF8IH/A' and click OK.

14. Select the module slot number and click OK. 
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15. In the DTM Networks window, right-click ' - (RSLinx 1756 
Backplane)'>1756Bus> - (1756 IF8H/A1)'.

16. Choose Online.

17. Click Scan network.

The Select Communications Channel window appears. 

18. Select the channels to perform the Scan Network on and click OK.
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Design for the Device

Any items found (temperature transmitter TT01001 in the example) are listed in 
the Items Found area of the Scan Results window. 

1. Click OK.

2. In the DTM Networks window, click Close.
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3. In the FactoryTalk AssetCentre window, select Design mode. 

4. Drag-and-drop the Instrument asset into the AssetCentre tree. 
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5. Click DTM Addressing Info and then click Browse (ellipsis ‘…’) to open 
the Select a DTM device from the DTM network window. 

6. Select a Process Device (TT01001 in the example) and click OK.
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7. Type the device name or tag and click OK.

8. Select DTM View, click the device (TT01001 in the example), and
click Online. 

IMPORTANT The Upload, Download, and Diagnostics functionality also
are available.
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9. Click Open to configure the device.

The Online configuration tab opens.
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10. Make any configuration changes you like.

When you are finished with changes, you can exit the FactoryTalk 
AssetCentre window. You also can return to the Home tab to make
more changes.
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Configure Disaster 
Recovery

Disaster Recovery software creates back-up files. This procedure schedules a 
comparison between master files, and processor program and data files. 

Configure a Logon

Complete these steps to configure the user name and password to enable the 
Agent service.

1. Click the Programs  symbol and choose Rockwell 
Software®>FactoryTalk AssetCentre Agent>
Agent service logon config tool. 

The Agent Services Logon Configuration dialog box appears. 

2. Type a user name (AssetCentre_DR in the example), password, and 
click OK.

After creating the logon, you must confirm that you need to restart 
the Agent Service. 

IMPORTANT The HART module must be configured in the I/O configuration tree. 
For details to enable HART channel data, see Chapter 5.
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3. Click Yes.

4. Perform step 1 and step 2 to reopen the Agent Service Logon 
Configuration dialog box. 

5. In the next dialog box that appears, confirm that the information is correct 
and click Close.

The Agent Service Logon Configuration dialog box closes. 

Add an Asset

To add a Logix5000™ controller as a new asset, complete the following steps.

1. In the FactoryTalk AssetCentre, click Design.

2. Drag-and-drop the Logix5000 Controller into AssetCentre.

IMPORTANT AssetCentre version 9 includes an asset for FactoryTalk View SE, version 11.
This asset can be created to support disaster recovery for a FactoryTalk View
SE application.
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The Add a Logix5000 Controller to AssetCentre dialog box appears. 

3. Choose Configuration Data and use Browse (ellipsis ‘…’) to find and 
click Add.

An .ACD file appears in the right side of the window. 

4. Select the .ACD file and click OK.
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5. In the Add a Logix5000 Controller to AssetCentre dialog box, choose 
Addressing Info.

6. Click Browse (ellipsis ‘…’).

The Selecting Device For Asset Type window appears.

7. Select the path to the controller and click Select.
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8. In the Add a Logix5000 Controller to AssetCentre dialog box, type the 
controller name (PAC01 in the example) and click OK. 
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Create a Working Folder

Complete these steps to set the workbook (working folder) in any level
of the structure.

1. In the FactoryTalk AssetCentre window, select Archive.

2. In the Archive tab, click Set for the Working folder. 

The Set Working Folders dialog box appears.

3. If the System working folder is incorrect, click Browse (ellipsis ‘…’).

4. In the Browse For Folder dialog box, navigate to the desired folder, select 
it, and click OK.

5. In the Set Working Folders dialog box, click OK.
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6. In the FactoryTalk AssetCentre software, make sure the Check In, Check 
Out, and Revision Control procedures are available in
the system.
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Create a Backup Schedule

Complete these steps to configure a backup schedule.

1. In the FactoryTalk AssetCentre Client, click the controller.

2. Select Schedules.

The Schedules tab appears. 

3. In the Schedules tab, Click New.

The 'New Schedule Wizard - Step 1 of 3' dialog box appears. 

4. Make sure that the Operation is correct.
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5. Type the name for the schedule and click Next.

The 'New Schedule Wizard - Step 2 of 3' dialog box appears. 

6. From the pull-down menu, select the Start Time.

7. Set the Timing Properties.
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8. Set the Maximum Runtime. 

9. Click Next.

The 'New Schedule Wizard - Step 3 of 3' dialog box appears. 

10. Select the Email notification option and click Finished.

IMPORTANT A maximum runtime of 0.0 means that there is no maximum limit.
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11. In the FactoryTalk AssetCentre - Schedules tab, click Run Now to test the 
functionality of the new schedule outside of the scheduling period.

The backup of the controller runs. After a few minutes, the backup 
is complete.
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Configure An Asset 
Inventory

This section describes procedures for configuring an inventory list of assets. 
Complete these steps.

1. In the FactoryTalk AssetCentre window, select Design mode. 

2. Drag-and-drop Asset Inventory into the AssetCentre tree. 

3. Click Scanning Configuration and then click Browse (ellipsis ‘…’). 
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4. From the Scanning Configuration dialog box, click Advanced Settings.

5. Type a community string and click Save.

6. Click OK.
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7. Type PlantPAx Inventory into the Name text box, and click OK.

8. Click Schedules on the menu bar, then click Inventory Schedule.
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9. Click Run Now to generate an inventory list.

10. To access the inventory list, right-click on the inventory name in the left 
column of the FactoryTalk AssetCentre dialog box.

11. Choose Open from the pull-down menu.
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You can view Devices or Software from the respective tabs.
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Chapter 8

Add Basic System Diagnostics

This chapter describes how to add controller and PASS server diagnostics to 
your system health screen that is provided in the HMI template. HMI 
templates are provided with the Rockwell Automation® Library of Process 
Objects. As you develop your project, you can add additional diagnostics for 
your system. 

We recommend that you familiarize yourself with the HMI template. See the 
Rockwell Library of Process Objects, Configuration and Usage Reference 
Manual, publication PROCES-RM002.

Figure 12 shows diagnostic displays that are explained in this chapter.

Figure 12 - HMI Diagnostics Example
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Figure 13 shows the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 13 - Basic Diagnostic Workflow 

Start

Configure Controller Diagnostics

See page 233

Add Controller Diagnostics to an HMI Project

See page 234

Configure PASS Server Status

See page 239

Additional Resources

See page 244

See Appendix A
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Configure Controller 
Diagnostics

The Logix Controller CPU Utilization (L_CPU) Add-On Instruction 
faceplate monitors a Logix controller and provides controller information on 
the system status page of the HMI template. This status information includes 
controller CPU utilization, communication usage, memory usage, task scan 
times, and controller loading.

1. In the Studio 5000 Architect® application, expand a controller project 
and open diagnostics under Controller Status.

2. Right-click LCPU and choose Open Routine.

The Logix Designer application opens with the LCPU routine.

3. In the MOV instruction, type the controller slot number into the
Source text box.

4. Save your project.

Use an Engineering Workstation 
with all procedures.

EWS
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Add Controller Diagnostics to 
an HMI Project

Follow these steps to add controller diagnostics to your HMI project.

1. From the Architect application, right-click an application and choose 
Open in Designer.

2. From your FactoryTalk® View project, expand your HMI application 
and displays.

3. Right-click a system diagnostic display (for example, process system) 
from the template and choose Open.
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4. From the Global Objects folder, right-click (RA-BAS) Logix Graphics 
Library and choose Open.

5. Right-click the controller graphic in the L_CPU box and choose Copy.
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6. On the Process system display, right-click anywhere in the window and
choose Paste.

7. Right-click the L_CPU graphics on the Process display and choose 
Global Object Parameter Values.

8. Type the controller shortcut string in #101.

IMPORTANT To open the L_CPU faceplate, you must open the Display folder 
under the FactoryTalk® View SE folder.
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9. Select the shortcut in #102, and click OK.

10. Save the display.

11. Open an HMI template.

12. On the HMI display, click the System Status icon.

On the HMI template, the controller graphic has some animation that 
shows the position of the key switch and controller status indicators.

System Status
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13. Click the controller to access the controller status faceplate.

Tabs on the faceplate also provide information on the CPU usage and 
the status of controller memory and connections. 

For details, see the PlantPAx® Library of Logix Diagnostic Objects, 
publication PROCES-RM003.

Home

Communication 

CPU Usage 

Maintenance

Controller Memory

Faults
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Configure PASS Server Status In this section, we describe how to add diagnostics for your PASS servers. 
These diagnostics provide information on the software components that run 
on the PASS, including an HMI server, data server, and an alarm and event 
server.

1. Open Knowledgebase Answer ID 44624 at http://
rockwellautomation.custhelp.com and download the
zip attachment.

2. Right-click the .zip file and choose Extract All.

3. Open the View 5.0 CPR9 folder.

4. Right-click the file and choose Open.

5. Right-click server status-state cpr9 v505 and choose Extract All.

The example shows the unzipped files.
Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 239

https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/


Chapter 8 Add Basic System Diagnostics
6. In the FactoryTalk View HMI application, right-click Displays and 
choose Add Component Into Application.

7. Open the server status-state cpr9 V505.gfx file from the files that were 
unzipped in step 5.

8. Right-click the imported display and choose VBA Code.
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9. Find the text circled in the example and type the name of your HMI 
server and data server.

10. Save the changes to the VBA code and close the server status display.

11. Open the Process system display.

12. From the Objects menu, choose Push Button>Button.
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13. Click the display and drag the mouse to draw a button.

14. From the Action tab, click Browse (ellipse ‘…’) next to Release action.

15. From the All Commands and Macros list, select Display and click Next.
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16. From the File pull-down menu, choose the server status display.

17. Click Finish.

18. On the Button Properties dialog box, click the Up Appearance tab.

19. In the Caption text box, type Server Status.

20. Click OK.

21. Save the changes to the Process system display.

22. Run the client file and access the System Status page.
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23. Click Server Status.

The Server Status display appears.

The example shows a networked station application with the 
FactoryTalk server, HMI server, and data server on one workstation. 
None of the servers are redundant in this application example.

Add These Additional 
Resources

The following resources are available to assist with developing your application.

IMPORTANT We recommend that diagnostic alarms for network adapters and I/O 
modules be added to the Alarm server. The alarms are displayed on 
the alarm banner and are included in the alarm log and history

Topic Description Where To Find Information

DLR diagnostics Device Level Ring (DLR) faceplate shows network status 
and where a break is in the EtherNet/IP™ network.

The DLR diagnostics faceplate application can be 
downloaded from the Rockwell Automation® Sample 
Code website at http://
samplecode.rockwellautomation.com 

L_ChangeDet, L_Redun, L_TaskMon library objects Objects that comprise the PlantPAx Library of Logix 
Diagnostic Objects manual monitor Logix controllers on 
the network, checking for changes that impact operation 
for primary and secondary controller status.

PlantPAx Library of Logix Diagnostic Objects,
publication PROCES-RM003
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Appendix A

Recommended I/O Module Ranges

You can scale your module to represent I/O data in specific terms for your 
application. When you scale a channel, you select two points that represent 
signal units: a Low Signal and a High Signal. You also select two points that 
represent engineering units: Low Engineering and High Engineering.

For example, if you are using the 1756-IF6I module in current mode, the 
module maintains a 0…21 mA range capability. But if your application uses a 
4…20 mA transmitter, you can scale the module to represent 4 mA as the low 
signal and 20 mA as the high signal.

The NAMUR NE 43 international standard uses the 3.8…20.5 mA signal 
range for measurement information. Likewise, signals >21 mA or <3.6 mA 
indicate diagnostic failures. By using the range values in the standard, 
instrument faults are separated from process measurements.

By staying within the NAMUR value references, instrument faults are 
separated from process measurements. Thus, you can adopt maintenance 
practices for instruments to operate at peak efficiency.

Figure 14 - NAMUR NE 43 Values.

0 22

4 mA 20 mA

Raw Units

3.6 21

0% 100%

Overrange Alarm

NE 43

Operating Range

Alarm Alarm

Underrange Alarm

Engineering Units

3.8 20.5
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An Overrange or Underrange condition is a common cause of inaccurate 
channel data reported to the controller. If an input signal is beyond the low and 
high signals for the module, the data is represented in terms of engineering 
units set during scaling.

Scaling Example Using I/O Value Range

In the example for the 1756-IF8IH HART module on page 142, the signal 
range is 4…20 mA and the engineering unit range 0…100%.

By default, module channels are scaled in current mode at 4…20 mA that 
equates to 0…100% engineering units. Other module channels scale 1:1 
regarding signal units and engineering units by default.

See the faceplates on page 247 for scaling by using the numbers in the example.

EXAMPLE Using our example, the 1756-IF8IH module in current mode supports 
0…22 mA actual range capability. But your application uses 
a 4…20 mA transmitter. 
• If you want to receive values in signal units, configure the module as 

follows:
– Low Signal = 4 mA
– High Signal = 20 mA
– Low Engineering = 4 EU
– High Engineering = 20 EU

• If you want to receive values of Percent of Full Scale, configure the 
module as follows:
– Low Signal = 0 mA
– High Signal = 20 mA
– Low Engineering = 0%
– High Engineering = 100%
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The pair of screens in the example shows a Basic and Advanced faceplates.

Using the values in the Example (on page 246), you want to configure scaling 
of the raw and engineering units on the Advanced faceplate. The raw values are 
entered in the Input text boxes and the engineering range and units are entered 
in the Scaled text boxes.

In the Threshold text boxes, which are shown on the Basic faceplate, enter the 
recommended threshold limits and Deadband in raw units. These values 
account for calibration tolerances and differ slightly from the NAMUR limits 
of 3.60…21.0 mA.

See Figure 15 for more details.

Figure 15 - Threshold Limits

Basic Faceplate Advanced Faceplate

By clicking the  icon, the Advanced faceplate appears to scale 
values based on your application requirements and the NAMUR values 
shown in Figure 14 on page 245.
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